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COPYRIGHT NOTICE 

© Trevor Caswell   2003-2004     All rights reserved 

Copyright exists on the contents of this manual and the software ‘PLEVTL.EXE’ supplied 
on the accompanying CD-ROM.  You agree by purchasing the software to use it on only 
one machine.  However, it may be transferred and used on another machine, but shall 
under no circumstances be used on more than one machine at a time.  One copy can be 
made of the software into any machine readable form for backup purposes only in support 
of your use of the software on a single machine. 

 

 

DISCLAIMER OF WARRANTY 

The software and manual are sold AS IS and without warranty as to performance.  
Because of the use to which this software may be put, and the variety of luminaires and 
hardware used in conjunction with it, no warranty of fitness for a particular purpose is 
offered.  Whilst the developer has invested considerable time and effort to create a high 
quality product, the user must assume the risk of using this software. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Trevor Caswell Software 
P.O. Box 236 

Salisbury,  Qld 4107 
Australia 

Ph. & Fax.:  (07) 3275 2406 
Int:  +61 7  3275 2406 
Mobile:  0417 732 763 

Email:  support@perfectlite.com 
Web:  www.perfectlite.com 
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1. INTRODUCTION 
 
The Vehicular Traffic Lighting (PLEVTL) software with the aid of the SAASTAN software can 
produce, in part, spacing tables which can be used as a design aid in lighting the straight/curved 
sections of Category ‘V’ roads.  The software can also be used for research purposes (Mode 3). 

It is assumed that the user has basic knowledge of the operations of IBM compatible personal 
computers and the Windows operating system. 

Before reading any further, briefly look through this manual and you will notice that screen 
snapshots have been used quite regularly.  This has been done to make it easier for you to equate 
the manual with the operation of the software.  The example used in the snapshots utilizes the 
sample photometric data supplied in the file named   Sample.cie. 

2. INSTALLING THE SOFTWARE 
The software is provided in either of two forms depending on how it was purchased (i.e. either as a 
stand alone version or as part of the main Perfect Lite software package).  In either case the 
Pedestrian Area Lighting software will be contained on a CD ROM and will require the following 
procedure to install the software correctly. 

First load the CD ROM into your CD Drive and click on the Start button,  Select Run… from the 
menu and type x:\Plevtl\setup.exe (x: is the drive letter of your CD) into the Run dialog box and 
then click OK. 

 

 

 

Follow the subsequent instructions on screen to correctly install the PLEVTL software on your 
computer.  Generally, it will only be necessary to click on the Next button several times to carry out 
the installation. 

It is recommended you choose the default folder (c:\Program Files\Perfect Lite) in which to install 
the software.  If you install it in another drive and/or folder then please make a note of the location 
below. 

PLEVTL software installed in:  ………………………………………………………….. 

3. REMOVING THE SOFTWARE 
Should the need arise you can uninstall the PLEVTL software by using the following procedure.  
Please note that it will only remove the components that were originally installed from the 
installation diskettes.  The folder where the program is located will remain with any files that you 
may have subsequently created or copied into the folder. 

First click on the Start button and select Settings and Control Panel from the fly out menu. 
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Then double click on the Add/Remove Programs icon. 

 
On the Add/Remove Programs Properties window scroll down to and highlight the Perfect Lite – 
Vehicular Traffic Lighting item and click on the Add/Remove… button. 
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Then click on the Yes button on the Confirm File Deletion message box. 

 

 
 

The various components of the software will then be removed and the screen as below will display 
the progress.  When complete click on the OK button. 

 

 
 

 

After that click on the Cancel button on the Add/Remove Programs Properties window and then 
close down the Control Panel group of icons. 

 



Perfect Lite - Vehicular Traffic Lighting to AS/NZS 1158.1.1:1997 Version 4.01 

© Copyright Trevor Caswell 2003-2004 Page 5 

 

4. STARTING THE SOFTWARE 
Click on the Start button and select Programs then Perfect Lite then Vehicular Traffic Lighting. 

 
The window as shown below should be displayed from where you can continue to operate the 
software.  If you are unfamiliar with the software then it is suggested you undertake the ‘brief tour 
of the software’ as described in the following section. 
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5. BRIEF TOUR OF THE SOFTWARE 
 
The Vehicular Traffic Lighting software (PLEVTL), with the aid of the SAASTAN software, can 
confirm compliance with the Light Technical Parameters referred to in Table 2.1 of 
AS/NZS1158.1.1:1997 for a road lighting layout.  The software can also produce spacing tables, 
both of these are used as design aids in lighting the straight/curved sections of Category ‘V’ roads. 
 
Category ‘V’ was introduced in the revised Code AS/NZS 1158.1.1:1997, released late in 1999. 
 
 
SAASTAN 
 
Just a couple of points to note about the SAASTAN software, supplied by Standards Australia with 
AS1158.2.  SAASTAN was a mid 1980’s Australian adaptation of the European STAN program 
used for road lighting (luminance) calculations.  It’s interesting to note that SAASTAN has not been 
modified since this time.  Some of you might remember that in the 1980’s PCs were relatively new, 
expensive and slow and, were just starting to be used by consultants and government 
departments.  Previously, mainframe computers were predominantly used for lighting calculations, 
if not done by ‘recipe methods’, which required different methods of input and output to what we 
take for granted these days.  The SAASTAN program had the legacy of the mainframe computer 
era in that it operated in a ‘Batch mode’ i.e. all input and output was via files, there was no 
interaction directly with the user.  This is how my SAASTAN User Interface came about, basically 
to make SAASTAN useable mainstream.  AS1158 basically requires the use of SAASTAN for 
determining compliance with the relevant Light technical Parameters specified in the Standard. 
 
There are many limitations with SAASTAN as you’ll find out when you try to apply it to real world 
situations.  Please note these limitations are in the SAASTAN software not my interface software. 
 
SAASTAN operates in three ways:- 
 
Mode 1 is used for luminaire evaluation i.e produces spacing tables for relatively standard 
layouts so that you might be able to compare the performance between different luminaires or 
manufacturers etc..  The user only nominates the I-table, mounting height and arrangement.  
SAASTAN makes other assumptions to produce the table/s.  In the days when SAASTAN first 
appeared it would take about half an hour for SAASTAN to calculate one table, hence Mode 1 was 
not regularly used. 
 
Mode 2 on the other hand, is used for individual installation design i.e. to check whether a 
certain lighting layout complies with the Light Technical Parameters for the applicable Category.  In 
this case, additional parameters can be nominated eg. luminaire spacing, carriageway width, 
median width and overhang.  My implementation of Mode 2 allows you to check a range of 
spacings to easily determine a maximum rather than do a series of trail and error single spacing 
calculations to reach a maximum.  In the days when SAASTAN first appeared it would take about a 
minute or so to calculate the results for a Mode 2 run. 
 
Mode 3 is used for installation performance analysis i.e. allows a few more variables to Mode 2 
but still has limitations.  In this mode you can specify the R-table to use (i.e. road surface 
reflectance), number of lanes per carriageway and width of each lane.  The position of the 
observer can also be nominated rather than the ‘standard’ position as in Mode 1 and 2.  This Mode 
is more complicated to use than Mode 2 and generally doesn’t achieve anything better and 
consequently was little used.  In the days when SAASTAN first appeared it would take about a 
minute to calculate the results for a Mode 3 run. 
 
If you want to know more about SAASTAN then you could obtain a copy of the following 
documents:- 
 

• ARRB Publication ARR106 - The Design and Implementation of Fixed Lighting for Arterial 
Roads and Freeways 

• CIE Publication No. 30.2 (TC-4.6) 1982 – Calculation and Measurement of Luminance 
and Illuminance in Road Lighting 



Perfect Lite - Vehicular Traffic Lighting to AS/NZS 1158.1.1:1997 Version 4.01 

© Copyright Trevor Caswell 2003-2004 Page 7 

 
 
Anyhow, lets get on with exploring the software you’ve purchased. 
 
 
Load an I-table 
 
Before you produce a spacing table (or do most anything else in the software) it is necessary to 
open up (or load) a photometric I-table.  These I-tables can be stored on your computer’s hard 
drive or floppy diskette as files or in the Library maintained by the software itself.  To get you up 
and running the software is supplied with a sample I-table file (Sample.cie) which corresponds to 
the one used in Appendix C of the AS1158.2.  This file is also loaded into the evaluation Library 
supplied with the software as code number 1.  Later in the tutorial I’ll describe how to load 
luminaires into the Library but for the moment we’ll just look at using the I-table from the file. 
 
From the File menu click on Open I-Table. 
 

 
 
This will then display the screen where you are required to input the file name (or luminaire code 
number). 
 

 
 
Each time you enter this screen (and most others in the program) the fields will be filled with the 
data last input.  Should you wish to select a different file then either type the name directly in the I-
Table File Name field, click on the down arrow to right of field to select from previous files used or 
click on the Browse button to invoke the standard Window File Open Dialog Box. 
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It should be noted that by default the dialog box will initially only display all the files with a “cie“ file 
extension, typical that of road lighting luminaires.  If this is not the type of file you are looking for 
make a choice from the Files of type drop down list box.  When the desired file is in the File name 
field click the Open button on the file dialog box to continue on with the software. 
 
When the file name has been entered click on the Next button to continue on with the software.  
On the subsequent screen input descriptions of the luminaire being used, initial flux value, 
maintenance factor etc.. 
 

 
 
Inputs in the description fields are only necessary for identification of the luminaire/lamp and will be 
included on any output produced by the software.  Once again when all the information has been 
entered click on the Next button. 
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You have now loaded the I-table file into the software and at this point you can view the 
photometric I-Table by selecting either of the top two items from the View menu. 
 

 
 
Spacing-Table/Check Compliance 
 
The main thing that we want to do is produce a spacing table or confirm compliance of a particular 
design.  From the Spacing Calculation menu select Mode 2 (Individual Installation Design)… . 
 

 
 
The screen will change to show several input fields to be filled with appropriate data relative to the 
table you wish to produce or road lighting design layout.  If this is the first time the software has 
been run it will probably have the default values as used in Appendix E of the Code. 
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For this tutorial alter the fields as they are on the above screen.  If you just wanted to check 
compliance for a single spacing just leave the upto and increments fields blank. 
 
Now might be a good time to talk about the On-line Help accessible within the software.  If you are 
in doubt as to what details should be input into any field then simply put the cursor in that field (ie. 
Left mouse click in the field) and press the F1 key.  A pop-up Help screen will appear giving you 
information on the contents of the field and limit of values that can be input.  This help feature is 
available for any item on a menu, any button or screen displayed.  To remove the Help screen click 
on the X in top right-hand corner of the Help screen. 
 
Now, press the Next button to get the software to carry out the necessary calculations to determine 
the maximum spacing for the range of spacings etc. selected.  An example of the top part of the 
resulting table then displayed on the screen is shown below. 
 

 
 
Use the scroll bar on the right side of the screen to move the display up to view more of the Table. 
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To print out the complete Table on your printer click on the Print button and the standard Windows 
print dialog box will be displayed.  Use can use this table for future situations where you have a 
similar arrangement.  Or if the results relate to a particular layout then you can simply check from 
the right most column if the design complies to the selected Category. 
 

 
 
Click on the Ok button to produce the printout. 
 
You can also save the results to a text file if you want by clicking on the Save As… button and the 
standard Windows save as dialog box will be displayed. 
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Click on the Save button to create the file, if the file already exists you get the choice whether to 
overwrite the file or append to it. 
 
Once the printout has been produced (or file saved) click on the Close button to remove the 
calculated results screen and return to the screen where you can change some of the input values 
and produce another table etc.  If you don’t wish to produce another table then click on the Cancel 
button.  This will take you back to the point where you can make another selection from the menu 
along the top line of the screen. 
 
To close down the program altogether select from the File menu the Exit option (or click on the X 
in the top right-hand corner of the software window). 
 

 
 
 
Add Luminaires to Library 
 
I mentioned earlier in this tutorial about loading luminaires into the Library maintained within the 
software.  It is relatively simple to do and after loaded only requires you to nominate a code 
number whenever you want to use that particular luminaire in a calculation etc. 
 
First, select from the File menu, the Luminaire Library menu then click on Add Luminaire…. 
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A file dialog box will be displayed where you input the name of the I-table file you wish to add.  In 
our case we’ll just add the evaluation luminaire in file, sample.cie.  If you want to add another file 
just use the Browse… button to locate that file.  Please note the Library and the SAASTAN 
program itself will only accept I-tables in the CIE/SAASTAN format not the IESNA format. 
 

 
 
Fill in the remainder of the fields on the screen as required.  If in doubt as to what should be 
entered into any field locate the cursor in that field and press the F1 key and a small Help window 
will appear. 
 
Click the Ok button and a confirmation message will be displayed to show the file has been saved 
in the Library. 
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List Luminaires in Library 
 
To list luminaires in the Library simply select the View menu and select the Luminaires in 
Library… item. 
 

 
 
A display similar to that below will appear.  By default the listing will show all the luminaires in the 
Library (i.e. Combined list).  If you just want those from one manufacturer pick the appropriate 
name from the Select a Manufacturer Name: drop down list box. 
 

 
 
The listing can be printed by clicking on the Print button. 
 
 
Remaining Choices from the Menu 
 
The remaining choices from the menu are pretty well self explanatory so I won’t go into detail of 
what they are about.  If you have doubts then place the cursor over the required menu item and 
while holding down the left mouse button press the F1 key and a pop-up Help screen will be 
displayed (sample for the View menu is below). 
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6. UPDATE HISTORY 
The following is a brief list of all the major changes that have taken place in the Perfect Lite – 
Vehicular Traffic Lighting software (and its predecessor the SAASTAN - User Interface) since 
inception. 

 
Vehicular Traffic Lighting software (PLEVTL) 
Version 4.01 (Released June 2004) 

• A ‘Tools’ menu has been added which incorporates the ‘Company name’ and 
‘Manufacturer names’ selections previously on the ‘File’ menu 

• New selection added to ‘Tools’ menu called ‘Options’ – this allow formatting (font name, 
font size & left margin width) of printed output 

• Due to access problems associated with Network security the configuration file (Plevtl-
user.cfg) is now stored in the same folder as the program (NOT root folder of C drive) 

• Curve spacing adjustment results can now be printed 
• Bug where the ‘Save As’ button on the results screen did not save the results to a file has 

been fixed 
• Program version/Date stamp on bottom of printouts has been modified slightly 

Version 4.00 (Released June 2003) 

• Windows 32-bit application incorporating many of the feature of the previous DOS based 
SAASTAN – User Interface software 

• By default, the software is installed in same folder as the Pedestrian Area Lighting 
software (i.e. c:\Program Files\Perfect Lite), the Perfect Lite ‘P’ category software 

• Validates the Company name entered against the serial number of the software 
• Routines added to Import/Export the PLEVTL Library files 
• Routine added to Import the previous SAASTAN – User Interface Library 
• Mode 2 automatically includes the previous F5 spacing range calculations 
• Wildcard characters in the I-table filename for Mode 2 (as in SAASTAN - User Interface) 

not yet incorporated 
• The Batch Mode facility has been removed 

 
SAASTAN – User Interface software (UIS97) 
Version 3.88a (Released May 2003) 

• Released with the Perfect Lite software package (Version 4.86a) 
• Allows wildcard characters in the I-table filename for Mode 2 - <F5> runs only. 
• Remaining calculation time display has been removed to increase speed 

Version 3.88 (Released October 2002) 

• Released with the Perfect Lite software package (Version 4.86) 
• Performance improved when running on Windows NT/2000/XP systems 
• Output layout slightly modified 
• For Mode 1, 2 & 3 calculations software now warns if the I-table nominated from a file is 

in the IES format 
• Allows output to be printed to a text file (PLE.TXT) rather than a specific printer 

Version 3.86 (Released May 2001) 

• Released with Perfect Lite Version 4.84 
• Modified to do all printing through the Windows Print Manager 
• Menu added at start of program to select printer for output 
• Changes to the Help file in particular to the input fields in Mode 3 

Version 3.85 (Released June 1998) 

• Released with Perfect Lite Version 4.82 
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• Several internal changes relating to Year 2000 compliance. 
• The maximum mounting height able to be input into the program has been increased to 

60 metres.  This allows for the use of high mast installations on very wide freeways etc..  
(To use wider than the 25 metre maximum road width set in SAASTAN a specially 
modified version of SAASTAN is required.) 

• Allows specification of a full pathname (eg. Drive letter, subdirectory, file name and 
extension) of photometric data files to be imported into the Library. 

• Selection of files for import uses the standard DOS file dialogue box for easier operation. 
• Detects the problem of SAASTAN not completing the creation of the SAAOUT file 

containing the calculation results on newer/faster PC’s.  The program reports the 
situation and advises of corrective action. 

• UIS97.EXE is now stand alone, that is, it can be executed directly from DOS, if desired, 
rather than going through the normal Perfect Lite menu system.  This is necessary 
sometimes if you get an error message, using the menu system, indicating you have 
‘insufficient conventional memory’ to run the program. 

Version 3.84 (Released April 1997) 

• Released with Perfect Lite Version 4.81 
• Mode 3 corrected - results only shown for nominated Observer positions NOT all 5. 
• Some limiting values on input fields increased for more practical extremes 
• Spacing range timing display corrected 
• Illuminance design noted for radius of curvature less than 100 metres 
• LTP's changed for revised standard (AS/NZS 1158.1.1-1997) 
• Rounding & compliance checking done properly to 2 significant places 
• 'Exit to DOS command l......' option removed 
• Summary display for Mode 2 changed to be on input screen 
• 'View last SAASTAN run results' replaced by 'View last Spacing run results' 
• UWLR102.EXE now referenced for Upward Waste Light Ratio 
• Luminaire spacing for Mode 3 NO longer twice for staggered arragnement 
• Cursor now returns to last field used after calculating for Mode 1 & 2 
• Help file changed to UIS97.HLP and updated 
• Initialisation file changed to UIS97.INI 
• Archive/Restore option removed as not considered any real use 

Version 3.83  

• 'Add luminaires....' option replaced by 'Insert luminaires....' 
• 'Archive/Restore' option added using PKZip style archiving routines 
• MAIN MENU now referred to as USER INTERFACE MENU 
• File 'SLCONFIG.DAT' now called "UIS.INI" and consists of only 8 lines (ie. Manufacturer 

names) 
• 'Modify manufacturer names' menu option added 
• 'SAAOUT' corrected so ‘overhang 2’ not shown if ARR=2 
• Only 1 luminaire per photometric data file allowed 
• Archives/Restores Batch run files as well (erases them when done) 
• Picks up where GLARE CANNOT BE CALCULATED and displays appropriate message 
• Disables MOUSE if file 'MOUSE.NO' found 

Version 3.82  

• Colour scheme passed from PLE.EXE 
• Photometric I-table data print out added 

Version 3.81  

• Spacing runs corrected to use changed input data 
• Summary of layout added to Spacing listing 
• Last spacing range used are displayed when 'F5' pressed 
• NZR2 (Dry) & NZN4 (Dry) road surfaces added to 'RTABLES.DAT' 
• Allows I-table file name to be used in lieu of luminaire reference no. 
• <F3> for luminaire list added to 'Delete/Change' screens 
• <F4> for Directory list of files at various points 
• 'Curve spacing adjustment' option added to main menu 
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• Max. median width & overhang increased to 20m 

Version 3.80  

• Almost totally revamped 
• Uses "ESCMODE" screens for data input 
• Converted to use Basic Compiler 7.1 and Probas Library fully 
• Luminaire description increased to 40 characters 
• Network printer Support (/LPT? option ) 
• Spacing range added to Mode 2 
• <F3> option added to Mode 1, 2 & 3 input screens 
• File 'OVERHANG' changed to 'OVER-HNG' 
• Maximum no. of lights in Library changed from 300 to 200 

Version 3.72  

• Maximum upcast angle increased to 60 degrees 
• Maximum carriageway width increased to 60 metres 

Version 3.71  

• Display of overhang included in summary lists 

Version 3.70  

• Uses Basic Compiler 7.0 and PLER-ENR library 

Version 3.51  

• Maximum carriageway width increased to 40m 
• Maximum overhang increased to 20m 

Version 3.5  

• uses PROBAS routines etc. 
• New menu systems using mouse 

Version 3.33  

• includes interface with 'CARL' 

Version 3.32  

• Mode 3 file format corrected 

Version 3.30  

• Improved menu selection 

Version 3.25  

• "SAAOUT" file cleared before "SAASTAN" is executed 

Version 3.22  

• Delayed batch execution added 

Version 3.20  

• Batch mode added 

Version 1.0 

• Original issue (1987) 
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